City of Auburn

Proposed Biennial Budget
FY 2017 & FY 2018

City Council Work Session #1
August 15, 2016
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Work Session #1

» Introduction
» Budget Overview - City Manager

» Capital Projects & Planning Initiatives - Assistant City
Manager

» Departmental Presentations
» Planning Department
» Public Works
» Environmental Services

» Water Resource Management

» Preview of Work Session #2
» Questions for the City Manager




Budget document at-a-glance

» General Information: Policy, planning and priority
documents; financial overview

» Introductory Information: Budget Message & Key Decisions
» General Fund

» Enterprise Funds

» Other Funds

» Capital Budgets

» Reference Information
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City of Auburn Mission Statement

The mission of the City of Auburn is to provide
economical delivery of quality services created
and designed in response to the needs of its
citizens rather than by habit or tradition
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City of Auburn Mission Statement

We will achieve this by:

» Encouraging planned and managed growth as a means of developing an attractive
built-environment and protecting and conserving our natural resources

» Creating diverse employment opportunities leading to an increased tax base
Providing and maintaining reliable and appropriate infrastructure

» Providing and promoting quality housing, educational, cultural and recreational
opportunities

Providing quality public safety services

» Operating an adequately funded city government in a financially responsible and
fiscally sound manner

» Recruiting and maintaining a highly motivated work force committed to excellence

» Facilitating citizen involvement



Where we are now - overview of General
Fund trends

» Revenues are stable and growing

» Operating costs have been consistently contained
» Reserves are strong

» Our debt is well-managed




10-Year Trends - General Fund (100 Only)
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Overview of General Fund trends -
revenues

» Revenues continue to see strong growth
» FY2006 through FY2015 average annual growth of 5.7%
» Sales & Use Tax

» 1 penny of sales tax generated $9.4M in FY2015; increase of nearly 40% since
FY2009

» 6% average annual increase over past five years
» Occupational License Fee
» FY2006 through FY2015 average annual growth of 4.3%
» FY2013 through FY2015 average annual growth of 5.4%
» Business License Fees
» FY2006 through FY2015 average annual growth of 7.0%
» FY2015 over FY2014 growth of 6.5%
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Sales Tax Revenue Trend
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General Fund
Largest Revenue Sources
Fiscal 2015

3.3% 2.4% 1.7% 1.5%

M Sales and use taxes

B Occupation license fees
B Business license fees

B Property taxes

B Pub safety fees - AU

® Lodging taxes
M Court fines and fees

I Building permits
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Overview of General Fund trends -
expenditures

» Operating costs kept to the absolute minimum to
get the job done

» Increased funding for Auburn City Schools

» Increased spending on capital projects & upgrading

older fleet
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10 -Year Trends - General Fund (100 Only) Exp. (adj.) *
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Where we are now - recap

» Strong reserves and revenues across all funds

» Continuing to hold operating costs down

» Well-managed debt

» More capital projects underway than ever before

» Service area and volumes are increasing; service levels need to keep
pace

But....
» Staff is stretched thin

» Several facilities at or above capacity
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Q1. Overall Satisfaction With City Services
by Major Category

by percentage of residents surveyed who rated the item as a 1 to 5 on a 5-point scale
(excluding don't knows)

Quality of police, fire, & ambulance services %////éfﬁ%////%
Quality of the city s school system : WW
Quality of city library services %//////M%///////

Collection of garbage, recycling & yard waste %////{/////Z%////%
Quality of the city s customer service %////////éﬁj&/////////ﬁ
Maintenance of city infrastructure %////////%Z;%/////////%
Enforcement of city codes and ordinances %////////////éﬁ;’%%//////////%
Effectiveness of city s communication w/ public %////////J%I%///////
Flow of traffic & congestion management %///%I%////%

0% 20% 40% 60% 80% 100%

‘-Uery Satisfied (5) ESatisfied (4) CINeutral (3) EDissatisfied (1/2) |

Source: ETC Institute (2016)
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TRENDS: Overall Satisfaction With City Services
by Major Category (2006, 2015, & 2016)

by percentage of respondents who rated the item as a 4 or 5 on a 5-point scale (excluding don't knows)

Quality of police, fire, & ambulance services

Quality of the city's schoal system

Quality of city library services

Collection of garbage, recycling & yard waste

not asked in 2006

Quality of parks & recreation services

Quality of the city's customer service

Maintenance of city infrastructure

Enforcement of city codes & ordinances

Effectiveness of city's communication with public

Flow of traffic & congestion management

0% 20% 40% 60% 80% 100%

2016 12015 2006 |
Source: ETC Institute (2016) ‘ TRENDS ‘
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TRENDS: Overall Perceptions of the City of Auburn
(2006, 2015, & 2016)

by percentage of respondents who rated the item as a 4 or 5 on a 5-point scale (excluding don't knows)

91%
91%
86%

87%
Overall image of the City 86%

Overall quality of life in the City

86%
Overall quality of City services 86%
?lf?%
76%
17%
71%,

|
75%
?Ilfi%
68% 1

0% 20% 40% 60% 80% 100%
2016 12015 E92006
Source: ETC Institute (2016) TRENDS

Overall appearance of the City

Walue received for your city tax dollars and fees




Satisfaction with Issues that Influence

Perceptions of the City
Auburn vs. the U.S.

by percentage of respondents who rated the item 4 or 5 on a 5-point scale
where 5 was "very satisfied" and 1 was "very dissatisfied" (excluding don't knows)

91%
Overall quality of life in the city
T4°r’o

87%
Overall image of the city

86%
Overall quality of City services

|
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Overall appearance of the city 679 I
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Value received for city tax dollars/fees
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TRENDS: Overall Satisfaction With City Services
by Major Category (2006, 2015, & 2016)

by percentage of respondents who rated the item as a 4 or 5 on a 5-point scale (excluding don't knows)
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Quality of police, fire, & ambulance services
Quality of the city's school system
Quality of city library services

Collection of garbage, recycling & yard waste

not asked in'2006

Quality of parks & recreation services

CQuality of the city's customer service
Maintenance of city infrastructure

Enforcement of city codes & ordinances
Effectiveness of city's communication with public

Flow of traffic & congestion management
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What’s our outlook?
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What’s our outlook?

» We’ll keep growing
» 1012 unbuilt single family lots as of May

» Several major multifamily complexes underway
» Demand for services will increase
» Many of our facilities are at or past capacity
» Many recreation programs continue to have waitlists

» Service area and volumes are increasing; service levels
need to keep pace

A L

City of Auburn




On what should we be
focused?




City Council FY17-FY18

Highe=t

Fricrity

Lowest

. . . ¥ votes # votes

Priority Distribution (mean] fa::::: Total number of votes selecting ranking Total number of votes selecting ranking Total number of vates selecting each item F::E?i:g
Prioritized Categories each item each item as indicated priority ?:(::i:itjlr: each item as indicated priarity ;?:E:;tl:;: az indicated priarity Ranking
[From highest to |awest, based an mean fanking) MEPHET| fot |2nd| 3id | ath [ Sth | tier | Gth | 7th | 8Bth | 9th |10tk tier | 11th | 12th | 13th | 14tk | 15th | 16tk

School funding ] 5 2 1 1 1]

Commercial development B 1 1 a4 2 1 1 ]

Downtown parking 5 1 1 3 4 1 3 ]

Industrial development 5 2 1 2 3 1 1 1 1

Street resurfacing a4 1 1 1 1 4 1 1 2 1

New community centers and gymnasiums a4 1 1 1 1 3 1 1 1 2

MNew outdoor athletic fields and facilities 2 1 1 5 2 1 2 2

Sidewalk construction/improvements 1 1 3 3 5

Intersection/street segment improvements 2 1 1 1 1 6

Continue Renew Opelika Road implementation 1] 6 1 3 2 3

Open space, green space and passive parks 1 1 3 1 1 1 5

Continue to implement Downtown Master Plan 2 1 1 3 1 1 1 a4

Traffic signal and signage improvements 1 1 5 1 2 2 3

Street light improvements 1 1 2 2 6

Mew and expanded pools ] 3 1 1 1 6

Funding for outside agencies ] (1] 9




Q2. Major Categories of City Services That Should
Receive the Most Emphasis Over the Next Two Years

by percentage of residents surveyed who selected the item as one of their top three choices

Flow of traffic & congestion management

60%

|
Maintenance of city infrastructure 46%

Quality of the city's school system -4-4-"","{;I

Quality of paolice, fire, & ambulance services 2:8%
|

|
Quality of parks & recreation services 2V%
|

|
Effectiveness of city's communication w/ public 25%

Enforcement of city codes/ordinances 20%

[
Callection of garbage, recycling & yard waste 13%!

|
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Cluality of the city's customer service 7% : :
| | |

| |
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| |

Cluality of city library services 5%:
|
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60%

‘-1st choice C2nd choice [13rd choice

Source: ETC Institute (2010)




2016 City of Auburn DirectionFinder Survey
Importance-Satisfaction Assessment Matrix

-Major Categories of City Services-

(points on the graph show deviations from the mean importance and satisfaction ratings given by respondents to the survey)

mean importance

Exceeded Expectations Continued Emphasis
lower importance/higher satisfaction higher importance/higher satisfaction

Cuality of police, fire, &
ambulance services «

Enforcement of city ®
codes & ordinances

o) I_Quality of c.:ity »Quality of the city's

c ibrary services school system

*‘G Collec_.tion of garbage, g
0 recycling & yard wastes Quality of parks & ﬁ
c recreation servicess @
) ®
-~ Quality of the city'se =
Q customer service ’ e E
“I'E caiﬁfﬁ'{:’g&?ﬁﬁ; ;’-"f)‘ ?:I' «Maintenance of city c
0N public infrastructure g
...3 =
0

Flow of traffic &
congestion managements

Less Important Opportunities for Imgrovement
lower importance/lower satisfaction igher imporiance/lower satistaction
Importance Rating Higher Importance

Source: ETC Institute (2016)
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Q22. Project or Initiative Priorities for the
City to Pursue Over the Next 3 Years

by percentage of residents surveyed who rated the item as a 1 to 5 on a 5-point scale
(excluding don't knows)

23% 17% . 9% | 9%
21% - 7% 18%

Downtown Parking Improvements

Opelika Road Improvements

Downtown Improvements 22%

Greenways & Pedestrian/Biking Trails E_ 26%
Town Creek Park Expansion 11% 14% - 33%
New Athletic Fields E- 41%
New Lake Wilmore Community o,
Recreation Center and Pool E- 6%
0% 60% 80% 100%

[-Highest OHigh CJAbove Average DAverage COBelow Average CJLow/Lowest
Source: ETC Institute (2016)




What’s our plan for the
next two years?

AL

P City of Auburn




Priority initiatives

» School funding

» Transportation infrastructure
» Public safety

» Parks, recreation & culture
» Economic development

» Auburn Downtown Master Plan implementation
» Renew Opelika Road Corridor Plan implementation
» Maintaining high quality citizen services
» Downtown parking
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Regular Full-time Positions
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Staffing levels need to catch up to keep up

» Budget proposes 31 new regular full-time positions
» Public Works Construction & Maintenance - 2

» Public Works - Inspections - 1

» Public Works - Traffic Engineering - 1

» Finance - 1 (upgrade from part-time)
»IT-GIS-1

» Environmental Services - Animal Control - 1

o
» Public Safety - Police - 24 (1 upgrade from part-time)




General Fund outlook

Beginning Fund Balance
Revenues

Other Financing Sources (OFS)
Total Revenues & OFS
Expenditures

Other Financing Uses (OFU)

Total Expenditures & OFU
Excess of Revenues & OFS over

Expenditures & OFU

Ending Fund Balance

Less: Permanent Reserve Fund
Net Ending Fund Balance

Net Ending Fund Balance as a %
of Expenditures and OFU

Mid-Year
Audited Actual Audited Actual Budget Budget
FY2014 FY2015 FY2016 FY2017 FY2018
S S S S S
34,465,547 38,324,103 40,607,239 29,789,081 29,402,574
71,514,687 76,871,583 76,373,960 81,500,106 83,771,995
296,250 461,250 436,250 361,250 351,250
71,810,937 77,332,833 76,810,210 81,861,356 84,123,245
54,889,302 56,387,064 73,647,493 67,642,613 69,376,775
13,063,079 18,662,632 13,980,875 14,605,250 14,416,660
67,952,381 75,049,696 87,628,368 82,247,863 83,793,435
3,858,556 2,283,136 (10,818,158) (386,507) 329,811
38,324,103 40,607,239 29,789,081 29,402,574 29,732,384
4,102,889 4,120,566 4,126,007 4,138,000 4,156,000
34,221,214 36,486,673 25,663,074 25,264,574 25,576,384
50.36% 48.62% 29.29%

30.72% -

a‘/‘




Beginning Fund Balances

Revenues

Other Financing Sources (OFS)
Total Revenues and OFS
Total Available Resources

Expenditures

Other Financing Uses (OFU)
Total Expenditures & Uses
Ending Fund Balances

Less: Permanent Reserve
Met Ending Fund Balances

Drawdown
Proj. NEFB (excl. Perm.Res.) as % of Exp & OFU

FY2017-FY2018 Biennial Budget - General Fund

Audited Mid-Year
Actuals Budget Proposed Proposed Projection
FY2015 FY2016 FY2017 FY2018 FY2019 FY2020 FY2021 FY2022
538,324,101 5 40,607,237 $ 20,789,079 5 20,402,571 $20,732,382 528,355,830 527,431,595 531,386,807
76,871,583 76,373,960 81,500,106 83,771,995 85,915,868 88,122,422 90,393,562 92,684,778
461,250 436,250 361,250 351,250 436,250 436,250 436,250 436,250
77,332,833 76,810,210 81,861,356 84,123,245 86,352,118 88,558,672 90,829,812 93,121,028
115,656,934 117,417,447 111,650,434 113,525,817 116,084,500 116,914,511 118,261,407 124,507,925
56,387,065 73,647,493 67,642,613 69,376,775 72,879,501 74,188,281 71,121,037 70,120,022
18,662,632 13,980,875 14,605,250 14,416,660 14,849,160 15,294,635 15,753,474 16,226,078
75,049,697 87,628,308 82,247,803 83,793,435 87,728,601 89,482,916 86,874,511 86,340,100
40,607,237 29,789,079 29,402,571 29,732,382 28,355,839 27,431,595 31,386,897 38,161,825
4,120,260 4,126,007 4,138,000 4,156,000 4,218,340 4,281,615 4,345,839 4,411,027
%36,486,671 $ 25,663,072 $ 25264571 5 25,576,382 $24,137,400 $23,140,080 $27,041,057 533,750,708
2,283,136 (10,818,158) (386,507) 329,811 (1,376,543) (924,244) 3,955,301 6,774,928
48.62% 29.29% 30.72% 30.52% 27.51% 25.87% 31.13% 39.09%




Debt Service Trends




General Fund Debt Service (adjusted)
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General Fund Debt Service (adj.) as % of Exp.
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Debt Service Outlook
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Annual General Fund Debt Service - As % of Total‘g
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Debt service outlook

» Declining debt requirements + stable economy + balanced budgets =
well positioned to absorb future capital demands

» City has managed timing and level of debt carefully
» Moody’s Aa2
» Standard & Poor’s AA+
» Better ratings = better interest rate = long-term $ savings

» Management weighs financial position, liquidity, capital markets and
current maturities carefully when considering long-term capital
financing

» Commitment to disciplined planning and vigilant monitoring is key to
continued financial stability
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On the horizon
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» Douglas J. Watson Municipal Complex Master Plan - August 23 |
» Americans with Disabilities Act Transition Plan Update - Fall 20
» Parks, Leisure and Culture Master Plan - March 2017
» Facilities Strategic Plan Update - Summer 2017
» Downtown Parking Study -Summer 2017

» Mid-Biennium Review - April-June 2017

City of Auburn
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City of Auburn
2017-2022
Capital Plan

FY 2017-2018 Biennial Budget Presentation
To the Auburn City Council
August 15, 2016




Capital Plan Focus Areas

» Downtown Improvements

» Opelika Road Improvements

» Transportation Improvements

» Facility Improvements

» Parks & Recreation Improvements

» Sewer/Stormwater Improvements

» Economic Development Improvements
» Technology Improvements
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Downtown Master Plan

Undertaken in concert with hands-
on community involvement, this
Plan reflects a balance of ideas
that seek to address the needs of
tomorrow while simultaneously
seeking to understand the
necessary steps for growth today.
On this notion, the Master Plan lays
out a realistic and community-
based vision for the future
expansion and growth of Downtown
Auburn as it pertains to private
development, open space and
streetscapes, circulation,
transportation, and economic
development.
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Downtown Vision and Goals

» “Auburn needs... new life and we » Expand Downtown
need to take history and charm
and make it work today. | picture
a permanent, walkable, dynamic » Enhance Streetscapes
Auburn - a city that celebrates
history and intellectual thinking
while driving into the future with » Improve Transportation
innovation.”

» Diversify Housing

» Expand Public Open Space

» Improve Parking

» Foster Downtown ldentity

» Build Partnerships
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Downtown
Completed Projects
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Toomer’s Oaks Removal
Auburn Oaks Planting

One Last Roll







Toomer’s Corner




Toomer’s Corner & Samford Park at
Toomer’s Corner

i
i
i
i
i
g
I
e
I
i
-

Toomer's Corner Image # 151006 0174
et Date 10.06.15
www.aerophoto.com




Toomer’s Corner & Samford Park at
Toomer’s Corner




Toomer’s Corner




Toomer’s Corner



Alley Project
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Alley Project
Outdoor Dining







Railroad Depot &
Mitcham Avenue Streetscape
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Railroad Depot &
Mitcham Avenue Streetscape




tcham Avenue Streetscape

Railroad Depot &
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Toomers Comer &
Samford Park at Toomers Corner

Railroad Depot &
Mitcham Avenue Stmu{s«.apu

Downtown Projects
I completed Project Area
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Downtown Auburn
Future Projects




Downtown Auburn
Future Projects FY 2016

» Pedestrian Lighting Master Plan

» Ross Street Streetscape

» North College Streetscape Phase 2

» College Street and Magnolia Avenue Street

Light Replacement

» North Gay Street Lighting
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Pedestrian Lighting Master Plan
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Ross Street Streetscape
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College Street and Magnolia Avenue .
Street Light Replacement
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Planning Initiatives
FY 2017

» Downtown Streetscape Master Plan

» Bragg Avenue - Martin King Luther, Jr. Dr. - NW Auburn Area

Plan
» Downtown Auburn Parking Review
» Citywide Traffic Study

» Comprehensive Plan Five Year Update




Downtown Auburn
Future Projects FY 2017

» Samford Avenue & South College Street Intersection

Improvements

» Wright Street Two-Way Improvements
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Samford Avenue & South College Street
Intersection Improvements
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Downtown Auburn
Future Projects FY 2018

» South College St. Streetscape - Garden Dr. to Woodfield Dr.
» Magnolia Avenue Streetscape

» Street Tree Replacement

» Parking Kiosks

» Tichenor Avenue Streetscape




South College St. Streetscape -

Garden Dr. to Woodfield Dr.
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Street Tree Replacement
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Tichenor Avenue Streetscape
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Downtown Auburn i
Future Projects FY 2019 |

» North College Street and Glenn Avenue

Intersection Improvements
» North Gay Street Streetscape Improvements

» East Glenn Avenue Streetscape - Gay Street to

Ross Street

s

A L

City of Auburn
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North College Street and Glenn Avenue |
Intersection Improvements
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North Gay Street Streetscape Improvements




East Glenn Avenue Streetscape -
Gay Street to Ross Street

Fiscal Year 2019

e
fhtncE R psEaE
LR e
L e
LR
L
i
.

L

m

cECR LN

HGaY st

riAR®

BRAGEAY

HARPERAL
WCAM AL
RRICR CT FoRD CT
"
1 . o
]
&
TICHENCR AV =
% i
b 5
¥
3
8
H
&
=
g
g
W MAGHCOLIAAY EMAGNOLIKAY
&
§
5
& o
# 5 £ g
b = z o
- 3 ] 2 3
H a ¢
o @

500 1,000 Feet
|

| Ol STonEMOusEwaAY

FOY UNIDN CIR




Downtown Auburn E

Future Projects FY 2020

» North College Street and Bragg Avenue and

Mitcham Avenue Intersection improvements
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Downtown Auburn
Future Projects FY 2021

» South College Street Streetscape - Samford

Avenue to Thach Avenue

» South Gay Street and Thach Avenue

Intersection Improvements

8

AL

City of Auburn




South College Street Streetscape -
Samford Avenue to Thach Avenue
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South Gay Street and Thach Avenue

ntersection Improvements

.~ Fiscal Year 2021
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Downtown Auburn
Future Projects FY 2022

» Drake Avenue Improvements
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Opelika Road Improvements
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RENEW OPELIKA ROAD

THE OPELIKA ROAD CORRIDOR PLAN

RENEW OPELIKA ROAD
CORRIDOR PLAN
Auburn, Alabama |
—— July 2013

The Renew Opelika Road '
Corridor Plan is the City of
Auburn’s plan to
aesthetically and
economically revitalize
Opelika Road.

. o ] 1
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-
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.

Plan recommendations are
designed to eliminate the
unattractive visual
environment, high levels of
vacancy, humerous curb
cuts, varying building
setbacks and forms,
insufficient pedestrian and
biking environments, and
outdated auto-oriented
buildings and road
configuration.
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Renew Opelika Road Phase 1
Infrastructure Concerns

» Aged Infrastructure

» Missing Infrastructure
(sidewalk, curb/gutter)

» Open Ditches

» Road Flooding

» Uncontrolled Access

» Wide Travel Lanes

» Poor Pedestrian Facilities

» Poor Biking Facilities




Strategy

» Commercial Development Incentive

Program

» Development Regulation Amendments
» Infrastructure Improvements

» Land Assemblage
» Branding

RENEW OPELIKA ROAD

THE OPELIKA ROAD CORRIDOR PLAN




Renew Opelika Road Phase 1
Gay Street To Ross Street
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Opelika Road
Completed Projects

City of Auburn






Ika Road Phase 1

Renew Opel




Renew Opelika Road Phase 2
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Renew Opelika Road Phase 2
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Opelika Road
Future Projects




Renew Opelika Road Phase 3
FY 2018

» Opelika Road / Dean Road Improvements

City of Auburn
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Renew Opelika Road Phase 4
FY 2019

» Ross Street to Temple Street Improvements
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Transportation Improvements




TRANSPORTATION IMPROVEMENTS

» Citywide Traffic Study

» Auburn High School Improvements

» Sidewalk Plan

» Resurfacing Plan

» Intersection and Traffic Signal Upgrades

» Future Traffic Signals




Sidewalks

Samford Avenue

East University Drive
Street Lights

Samford Avenue

Traffic Signals and Pedestrian
Access

Glenn Avenue & Airport Road
Glenn Avenue & Samford Avenue

East University Drive & Samford
Avenue

Drainage Culvert

Samford Avenue near East
University Drive
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Resurfacing Plan

Resurfacmg Plan 2016 - 2021

Resurfacing Plan
s Resurfacing 2016
Resurfacing 2017
s Resurfacing 2018
s Resurfacing 2019
s Resurfacing 2020
= » Resurfacing 2021
—— City of Auburn Streets
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Intersection & Traffic Signal Upgrades

»  Fiscal Year 2016 > Fiscal Year 2019

. . » North College Street & Glenn Avenue
» Woodfield Drive & South College g

. » Glenn Avenue & Ross Street
» Gay Street & Magnolia Avenue

. . . . » Glenn Avenue & Gay Street
» Moores Mill Road & East University Drive

) ) » Gay Street & Mitcham Avenue
p»  Moores Mill Road & Grove Hill Road

»  Fiscal Year 2017

» South College & Donahue Drive

» Highway 14 & Donahue Drive

» Glenn Avenue & Airport Road .
»  Fiscal Year 2020

Glenn Avenue & Samford Avenue
. » Gay Street & Thach Avenue

> Highway 14 & Richland Road » North College Street & Mitcham & Bragg

» East University Drive & Gatewood Drive Avenue
» South College Street & Samford Avenue » Moores Mill Road & Ogletree/Hamilton
Road

» Gay Street & Samford Avenue
»  Fiscal Year 2018
p Cox Road & Wire Road

»  Fiscal Year 2021
» North College Street & Shelton Mill Road
»  Fiscal Year 2022
> Opelika Road & Dean Road » East University Drive & Annalue Drive

» North College Street & Drake

» North Gay Street & Drake Avenue
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Upgrade Fiscal Year
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Future Traffic Signals

» Shug Jordan Pkwy. & Samford Av
» South College St. & Sandhill/Cox Rd

» South College St. & Shell Toomer
Pkwy.

» North Donahue Dr. & Farmville Rd.

» Opelika Rd. & DeKalb St.

» Opelika Rd. & Saugahatchee Rd.

» Glenn Av. & Skyway Dr.

» Hwy 14 and Webster Rd.

Future Traffic Signals [

P Future Traffic Signals
$E  Existing Traffic Signals
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Planning Department

FY 2017-2018 Biennial Budget Presentation
to the Auburn City Council
August 15, 2016

City of Auburn




Growth Model Version 3
(Comprehensive Update of AIGM)

The original AIGM was completed in 2008. It has been updated by Planning staff on a bi-
annual basis since that time. With the AIGM providing the “data foundation” for
CompPlan 2030, the Planning Department is working with our AIGM consultant to build
“from the ground up” a new refined model in conjunction with the first five-year update
of CompPlan 2030. This model will help Planning develop an appropriate optimal growth
boundary and enable the city to accurately identify future infrastructure needs and
address them.

Measurement Focus: Completion of update by December 31, 2016
Reference: CompPlan 2030, Land Use Chapter
Cost: 534,000

Funding Source: Departmental Budget

vV v v Vv



Complete land use study for the MLK/Bragg Avuenue corridor and Northwest Auburn
neighborhood planning initiative.

» Measurement focus: Completion of study by January 31, 2017
» Reference: CompPlan 2030, Land Use Chapter

» Cost: N/A

» Funding Source: N/A




Annual Report to Planning Commission

FY 2011
Annual Report
to the
Planning Commission

3}

Publish FY 2016 Annual Report to the Planning Commission

AL
» Measurement Focus: Completion of update by February 9, 2017 City of Auburn
» Reference:
» Cost: $1,000
>

Funding Source: Departmental Budget

City of Auburn



CompPlan 2030 Five-Year Update

The City has committed to a five-year comprehensive update of CompPlan 2030 (adopted
October 2011). The intent of the five-year update cycle is to ensure that the Plan adjusts
to changing conditions and maintains its relevancy over time.

» Measurement Focus: Completion of update by March 31, 2017
» Reference: CompPlan 2030

» Cost: N/A

» Funding Source: N/A

AL

City of Auburn
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Develop a Streetscape Master Plan for Downtown (UN and UC districts) that would include /Dean
preferred spatial standards, uses, materials, site furnishings, street tree master plan,
lighting strategies, branding and signage recommendations with an emphasis on the
overall aesthetic for Downtown Auburn

Measurement Focus: Completion of plan by June 30, 2017
Reference: Downtown Master Plan Implementation
Cost: $25,000

Funding Source: Departmental Budget

vV v vy




Glenn/Dean Area Study

Conduct a study of the East Glenn Avenue and North Dean Road intersection
and its environs. The study will evaluate the current conditions, zoning, and
land use designations and make recommendations for appropriate change.

Measurement Focus: Complete study by August 31, 2017
Reference: Planning Commission directive

Cost: N/A

vV v v Vv

Funding Source: N/A
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Citizens’ Planning Academy

L S b
I T N

Conduct the sixth offering of the Citizens’ Planning Academy during Fall 2017/FY
2018.

Measurement Focus: Completion of classes by November 15, 2017 OOdJrEE';ort
Reference: - o Plat
er Ave

Cost: N/A

Funding Source: N/A /

vV v v Vv
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Food Truck Regulations

Revisit with the Planning Commission consideration of regulations for food trucks.

FY

Foo
Reference: bal Report

Cost: N/A
Funding Source: N/A

Measurement Focus: Completion of study by December 31, 2017

vV v v Vv




Annual Report to Planning Commission

FY 2011
Annual Report
to the
Planning Commission

Publish FY 2017 Annual Report to the Planning Commission A
AL

City of Auburn

» Measurement Focus: Completion of update by February 8, 2018

» Reference:
» Cost: $1,000

» Funding Source: Departmental Budget
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City of Auburn
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Explore standards for regulating condominium plats in an effort to better manage
residential and commercial development that fronts private streets.

Measurement Focus: Completion of study by March 30, 2018

Reference: Departmental Objective; Planning Commission Directive
Cost: N/A

Funding Source: N/A




Harper Avenue Focus Area Study

g “@ w | e I_l._ ;J 8 < - ‘.}I;- _ ._. v l.- Ei II.

Conduct study of Harper Avenue Focus Area with an emphasis on examination of
land use and zoning adjustments that might better facilitate redevelopment and
continued rehabilitation of the subject area.

jual Report
do Plat

Measurement Focus: Completion of study by August 31, 2018
Reference: CompPlan 2030, Land Use Chapter |
Cost: N/A 7
Funding Source: N/A //
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City of Auburn




Public Works Department

FY 2017-2018 Biennial Budget Presentation
To The Auburn City Council
August 15, 2016

Jeffery L. Ramsey, P.E.
Director of Public Works/City Engine




Public Works Department
Plan, Design, Construct & Manage

The Public Works Department is made up of five divisions:

\
1
1
\
\

Administrative
Engineering
Traffic Engineering

Inspection

vV v. v v Vv

Construction and Maintenance

\‘ Jeff Ramsey, P.E.
Public Works Director & City Engineer

A L

City of Auburn




PUinc Works Department ASupervised jointly by the Public Works

Director and Finance Director

{334) 501-3000
1
| | | 1 | 1 1
: 5 : : Construction & : : : y
PW Accountant® Ad mlms_:tratlve PW Inspection Traffic Engineer e ——— Assmtz_ant City Engineering
Coordinator Manager S Engineer Manager
Division Manager
|
| I 1 | | |
Customer Service Traffic Systems Sign Maintenance C&M Crew C&M Crew Facilities . .
i i L : A : i Mapping Specialist
Representative Aeniorinspector Technician Technician Coordinator Coordinator haintenance
Coordinator
Admin Secretary I ] —(;(I\T(;aw___g\‘ 7 -~ |_ Eacilities il En ,
(2) Traffic Co-Op o g g g Il Leader/Heavy [ | ~|C&M Crew Leader \I Maintenance ivil Engineer (2)
PW Inspector (5) (27p) raffic Technician ! ¢ 0if e Fator : I E | Worker
1 (=] L
I i -E I Heawy Equipment g I 1 1
i i i ivisi Traffic Technician bl b I+ N S |
Traffic Engineering Division ok worker (2) S ) Operator g Land Acquisition Civil Engineer for
2o 2 Specialist Development
e L |
. ) \ Maint 2
Construction & Maintenance {cam Crew teader| | H Vs'orlfe"ra(";)e S ‘I [ 1
ivisi Administrative Division \
Division [ : : _"——-L./ Drafting Survey Crew
@ / hY Supervisor Leader
s
E s % g . I | Heavy Equipment | 2 | |l cam crew Leader |
Engineering Division Inspection Division Operator F 1 | L |_
£
& I I CAD Operator Survey Technician
1 . p
Maintenance < 1] P Heawy Equipment | 2 |
1 Worker (2) ’I BpRratar g I
\
Comparative Summary of Authorized Personnel (Regular Full-Time Onily) e e - % :
Mainte nance % |
FY 2014 FY 2015 FY 2016 FY 2017 FY 2018 1 worker (1) 2
Administration 6 6 6 6 6 ke |
Engineering 11 11 11 11 11 I
Traffic Eng. 3 3 3 5 5 —| Cement Finisher |
Inspection ] ] 6 7 7 \ /
Const. & Maint. 18 18 18 20 20 e

TOTAL 44 44 44 49 49




Public Works Department
FY 2015 Year In Review

» Administrative Division

» Completed 24 project manuals and processed the post-bid work

» Engineering Division

» Designed 16 projects in-house

» Traffic Engineering Division
» Replaced 64 LEDs for both traffic signals and illuminated street name sign and
maintained 61 traffic signals
» Inspection Division

» Inspected 288 storm water retention facilities

» Construction and Maintenance Division

» Constructed or repaired 2,859 feet of sidewalk and placed 746 tons of asphalt
alligator repair on streets throughout the City
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Administrative Division

The Administrative Division provides leadership, general
oversight and administrative support for four operational
divisions.

>
>
>
>

Oversees the bidding process
Handles citizens concerns
Contract management

Bonds & agreements

Audrea Maye
Administrative Coordinator




Engineering Division

The Engineering Division consists of a team of civil
engineers, draftsmen and land surveyors.

» Develops plans and specifications
» Coordinates with developers and builders
» Manages major construction projects

» Provides technical assistance to other departments

Alison Frazier, P.E.
Engineering Manager
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FY 17 Engineering Division Goals

» Widening of Moores Mill Road Bridge over 1-85

» East University Drive Sidewalk (Samford Avenue to McKinley Avenue)

» Moores Mill Road Sidewalk (Samford Avenue to East University Drive)

» College Street and Samford Avenue Intersection Improvements

» Highway 14 (Martin Luther King Drive) at Richland Road Left Turn Lane

» Samford Avenue Sidewalk Project (East University Drive to the Auburn High
School property, approximately 720, beginning just east of Jockish Street)

» Samford Avenue Culvert Replacement (near East University Drive)
» Cured-in-Place Pipe Project
» Wright Street Sidewalk and Resurfacing Project

8
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City of Auburn



FY 18 Engineering Division Goals

Annalue Drive Sidewalk Construction (Dean Road to East University Drive)
Renew Opelika Road Phase 3 (Dean Road Area)

Cox Road and Wire Road Intersection Improvements
Cured-in-Place Pipe Project

Cox Road Widening and Resurfacing

Downtown Improvements

vV v v vV v Vv Y

Saugahatchee Greenway Phase | Construction

8
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City of Auburn




City of Auburn

South College Street and Longleaf Drive
Intersection Improvements - FY 2016
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Traffic Engineering

The Traffic Engineering Division investigates complaints regarding traffic
problems and monitors traffic volume information within the City’s
transportation systems

» Installs and maintains traffic signs and signals
» Works with citizens on traffic calming issues

» Develops traffic impact studies

» Reviews traffic impact studies from developers

» Coordinates the interests of cyclists

Brandy Ezelle, P.E.

Traffic Engineer

A L

City of Auburn
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FY 17 Traffic Engineering Division Goals

Travel with Care Safety Campaign

Signal Rehabilitation/Improvements/Upgrades

East University Drive and Gatewood Drive Intersection Safety Improvements
East University Drive and Samford Avenue Pedestrian Improvements

Glenn Avenue and Samford Avenue Traffic Signal Modification

Glenn Avenue and Airport Road Traffic Signal Modification

East Samford Avenue Street Lighting Project

Tiger Transit Bus Turnout

Citywide Traffic Study

vV Vv vV vV v v vYy
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FY 18 Traffic Engineering Division Goals

» Travel with Care Safety Campaign

» Signal Rehabilitation/Improvements/Upgrades
» Tiger Transit Bus Turnout

» Magnolia Avenue Pedestrian Lighting

» Downtown Parking Meter Replacement

8
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Inspection Division

The Inspection Division is responsible for enforcing laws and
ordinances related to public utilities (water and sewer),
roadways, sidewalks, and drainage and sewer structures

» Oversees installation of public infrastructure
» Manages construction projects
» Coordinates implementation of development requirements

» Coordinates resolution of construction related complaints

David Ponder
“ Inspections Manager




FY 17 Inspection Division Goals

» Annual detention pond inspections

» Streets resurfacing and restriping projects

» Provide inspections for various City projects

» Provide inspections for various ALDOT projects

» Douglas J. Watson Municipal Complex Phase 2




FY 18 Inspection Division Goals

» Annual detention pond inspections
» Streets resurfacing and restriping projects
» Provide inspections for various city projects

» Provide inspections for various ALDOT projects
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Construction &
Maintenance Division

City’s roadways and storm water drainage system (including creeks and streams). The Di
also the first responder to emergency events such as winter storms, wind events and other
emergency situations \

Maintains City’s drainage structures
Maintains City streets

Maintains and constructs sidewalks

vV v v Vv

Performs buildings maintenance

Jay Uphold

C & M Division Manager

A L

City of Auburn




FY 17 Construction and Maintenance
Division Goals

» Maintain Streets, sidewalks, and drainage structures
» Emergency response preparation & management

» Annual Neighborhood Clean-Up Program

» Sanders Street Sidewalk/Pedestrian Bridge Project
» South Cary Drive Sidewalk Project

» Heard Avenue Culvert Rehabilitation Project
» Facility Maintenance Division

8
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FY 18 Construction and Maintenance
Division Goals

» Maintain streets, sidewalks, and drainage structures
» Emergency response preparation & management

» Annual Neighborhood Clean-Up Program

» Keystone Drive Sidewalk Project

» College Street/Bragg Avenue & College Street/Mitcham
Avenue Storm Drain Improvements Project

» North College Street and Drake Avenue Storm Drain Pipe
Extension Project

8
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Environmental Services
Department

FY 2017 - 2018 Biennial Budget Presentation
To the Auburn City Council
August 15, 2016

City of Auburn



Administration Division

Expansion of ES admin facility in FY 2018
» Facility constructed in 1998
» Need more meeting and office space

» Expansion from 4,200 square feet to at least 5,200
square feet

» FY 2017 CIP budget of $15,000 for architectural

» FY 2018 CIP budget of $200,000 for construction,
supplies, etc.
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Request for an additional animal control officer
position in FY 2017

In 1987, initial AC position was created in ES

Only regular daytime work hours with no on-call
scheduling

In 1995, added an additional AC position
Eventually began on-call scheduling

Have not added an officer since 1995 (21 years)
Services offered have evolved
Human and animal population has increased

Number of calls have increased 5% or more each
year

Two officers on a bi-weekly on-call schedule
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Fleet Services Division

Reclassify two Service Technician slots to Mechanic | slots
» Service Technicians spending 50% of time doing Mechanic | level work

» Continued emphasis on training in automotive technology
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City of Auburn




Right-of-Way Maintenance Division

» Annual Neighborhood Cleanup Project (since 2011)
» Litter Index
» Vegetation management

» To enhance maintenance scheduling, request purchase of
replacement mowers and a skid loader

» Vector abatement

» Budget funds requested to provide for additional pesticide
material to deal with mosquito abatement concerns surrounding
the Zika virus, etc.




Solid Waste Management Fund

Five-Year Tonnage Totals

Trash/Yard Waste | Recycling

11,078 11,181* 1,089 23,348
11,383 10,762 1,392** 23,537
11,918 11,226 1,376 24,520
12,106 12,048 1,384 25,538
12,597 12,352 1,402 26,351

*Anomaly due to 2011 tornado event
*Added cardboard recycling downtown




Recycling Division
Facility improvements
ADA upgrade of recycling drop-off center
FY 2017 CIP budget of $100,000

In FY 2018, possible commingled recycling
pilot project

Trash Amnesty Week program
Annual amnesty week since 2005

Spring of FY 2017, possibility of offering a
Trash Amnesty “Month”




Solid Waste Management Fund (cont’d)

Solid Waste Division

» Evaluate the collection route in FY 2018
» Last route evaluation in 2011
» 14,685 residential customers (as of June 2016)
» In FY 2015, made 728,000 residential stops
» HHW collection
» Held annually since 2003

» Evaluate the possibility of establishing a permanent collection site or hosting
a quarterly/bi-annual disposal event
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Water Resource Management
Department

FY 2017-2018 Biennial Budget Presentation
To the Auburn City Council
August 15, 2016

Eric Carson, P.E.
Director of Water Resource Mana ent
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City of Auburn




Outline

» Departmental Overview
» Water

» FY 17/18 Projects

» Future Goals and Initiatives
» Sewer

» FY 17/18 Projects

» Future Goals and Initiatives
» Watershed

» FY 17/18 Projects

» Future Goals and Initiatives




Departmental Overview

WRM is responsible for:

» Water Treatment and Distribution
» Wastewater Collection and Treatment

» Watershed Management




Departmental Overview

Water Statistics
» 300 miles of water main
» 2,500 hydrants

» 6 elevated water storage tanks (5.5 million gallons of storage)

» 2 booster stations

» 21,815 water meters

» 1 treatment facility (8 mgd)

» 1 well (1.3 mgd)

» 4 interconnections with Opelika Utilities (3.6 mgd)

» Respond to over 22,500 water service requests per year

3
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Departmental Overview

Sewer Statistics

» 350 miles of sewer main

» 7,000 manholes

» Service lines for over 18,000 customers

» 13 wastewater pumping stations

» 2 wastewater treatment facilities
» H.C. Morgan WPCF (active) - 11.25 mgd treatment capacity
» Northside WPCF (inactive) - 2 mgd treatment capacity

» Respond to over 450 sewer service calls per year

» Perform over 7,200 line locates per year
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Departmental Statistics

Watershed Division Statistics

» Perform over 1,000 erosion and sediment control inspections per year

» Obtain more than 10,000 water quality measurements throughout the
City’s local water resources per year

» Conduct numerous presentations and other public education and
outreach events

» 825 miles of stream in and around the immediate Auburn area
» Over 1,000 lakes and ponds (over 2,200 acres of open water)

» Over 2,800 acres of wetland in and around Auburn

AL

City of Auburn



Water Resource Management Department

Eric A. Carson, PE

Water Resource
Management
Director

(334) 501-3060

[ Administration Division ] Wt Rl - - -
lwaai;gzﬁ:r::e Principal Utility Water Distribution Administrative
. Lo N "
[ Sewer Maintenance DIVISIOI’]] Assistan: Director Engineer Manager Secretary
[ Watershed Division ] I | I | 1
" il Student WRM Water Plant Meter Technician Water Coordinator
Water Treatment & Pumping WRM Utility o Manager* (5)* *
L Engineer Specialist
Division
— | 1
[ Water Distribution Division] — WRM Complex I
ility System Tech Chief Water Plant Facilities AdmlmstratLve
Utili
Administrative Operator * Coordinator * Secretary
Secretary
Utility System GIS Utility Construction
Specialist Water Plant Supervisor *
Operator (4) *
[ 1 Utility Maintenance
I Worker (7) * * d |
Collection System Watershed Division ] Water Board employee(s)
Water Treat Maint.
Manager Manager
Crew Leader*

Heavy Equipment
| | Operator (2) *
Stormwater Water Treat P @

— Program it
Collection System Collection System Coordinator Facilities
Program Coord Supervisor Main Technician *
Watershed
- . — Program
I_ Utility Maintenance Coorginator
Utility Locator (3) Worker (6) Comparative Summary of Authorized Personnel (Regular Full-Time Only)
FY 2014 FY 2015 FY 2016 FY 2017 FY 2018

) | Student WRM Administration 9 9 8 8 8
Heavy Equipment Specialist (TP) Sewer Maintenance 1 13 15 15 15
Operator (3) Watershed Division 3 3 3 3 3
Water Treatment and Pumping 7 7 8 8 8
Water Distribution 18 18 19 19 19

TOTAL /City/WB 48/23/25* 50/25/25* 53/26/27 * 53/26/27* 53/26/27*
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Departmental Staff Overview

» Total Staff = 52

» Professional Expertise
» 4 Professional Engineers
» 1 Professional Landscape Architect &
» College Degrees
» Bachelor’s = 10
» Masters’ =5
» Various other certifications

» 6 Water Operator Certifications

» 6 Wastewater Operator Certifications
» 25 CDL certifications

3
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Departmental Overview

Recent Accomplishments (FY 15/16)

>
>

>

vV v v Vv

Completed renovations to the James Estes WTP

Constructed new raw water pump station at Lake Ogletree (12.5 mgd
capacity)

Rehabbed 2.8 miles of sewer main (cured in place pipe lining and pipe
bursting)

Completing H.C. Morgan Blower Improvements Project (August 2016)

Upgraded downtown water and sewer infrastructure (Toomer’s Corner/Alley,
Magnolia Avenue)

Installed last diesel bypass pump at Stone Creek lift station
Sewer Mapping Project - Substantially complete
In-house Source Water Monitoring Program

Developed an electronic-based erosion and sediment control inspectio
program using CityWorks
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LAKE OGLETREE RAW WATER PUMP STATION PROJECT 2014

Pump Station #2: Flood in August 2013

O 2

Pump Station: February 201




Blower P

New 400 hp Aerzen Turbo Blower



Water Projects (FY17/18)

» Lake Ogletree Spillway Improvements Project
» WRM Fueling Station

» AWWB Pole Barn Expansion

» WTP Lime Feed Modifications

» WTP Carbon Feed System Modifications

s \

AL
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Water - Future Goals and Initiatives

» Water Treatment Capacity
» Treatment capacity adequate for 5 - 15 years
» Facility Master Plan
» Long Range Water Supply
» Martin Marietta Quarry
» Renegotiate contract with Opelika Utilities
» Expand Estes WTP to 10 mgd with addition of 2 new filters
» Well No. 3 - Extension of run time
» Water Quality Improvements
» Disinfection Byproducts
» Downsizing mains (ex. Stonewall Road)

» Well No. 3 - High quality water
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Martin Marietta Quarry




Sewer Projects (FY 17/18)

» H.C. Morgan WPCF Generator Replacement Project
» H.C. Morgan WPCF Admin Building Renovations

» Biosolids Disposal Property Evaluation/Purchase

» Long term sewer flow monitoring network

» Sewer Rehab

» Southside Basin 6 (West Longleaf Drive, West Veterans Boulevard) - SSES
(FY17); Rehab (FY18) - 7.7 miles of sewer main in Basin 6

» Southside Basin 16 (West Glenn Avenue, Hemlock Drive, West Magnolia) -
SSES (FY18); Rehab (FY19) - 8.3 miles of sewer main in Basin 16

» Sewer infrastructure relocation - Glenn/College intersection
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Biosolids Land Application
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Sewer - Future Goals and Initiatives

» Sewer Capacity
» Treatment Capacity - Adequate for next 15 to 20 years
» Collection System Capacity
» Implementation of Sewer Model
» Long Term Flow Monitoring Project
» Continue to address inflow/infiltration through sewer rehab projects

» Challenges - Aging infrastructure and downtown development
» Sewer Ordinance Updates

» Sewer Taps

» Fats, Oils, Grease (FOG) Program (rates, hauler certification, continue accepting
grease or not)

» Consolidate multiple old ordinances into one new comprehensive ordinance

» Preventative Maintenance of Collection System (CCTV, cleaning, FOG
program, easement maintenance)
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Watershed FY 17/18 Projects

» Green Infrastructure Master Plan
» Saugahatchee G + B Project
» H.C. Morgan Stream Restoration Project

» Stream Flow Monitoring Program

» Saugahatchee - FY17
» Parkerson Mill - FY18

» Moore’s Mill and Town Creek - Future

s\

» Source Water Monitoring Program
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Watershed - Future Goals and Initiatives

» Implementation of Green Infrastructure Master Plan

» Continue implementation of Saugahatchee G + B project

» Continue to expand and enhance the source water monitoring

program
» Water Quality Monitoring Stations (using stream gage sites)

» Public Education/Outreach (Lee County Water Festival, Earth
Day, ESC Workshop)
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Murphy Armor Mill Stream Gaging Station-
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Questions?

City of Auburn




Agenda for next time

Next Work Session will be Wednesday, August
24, at 5:30 p.m. in this room.

» Departmental Presentations
» Outside Agency support discussion

» Key Decisions
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